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SAFETY WARNING
Only qualified personnel should install and service the equipment. The installation, starting up, and servicing of 
heating, ventilating, and air-conditioning equipment can be hazardous and requires specific knowledge and training. 
Improperly installed, adjusted or altered equipment by an unqualified person could result in death or serious injury. 
When working on the equipment, observe all precautions in the literature and on the tags, stickers, and labels that are 
attached to the equipment.



Introduction

This document covers installation, connection techniques used for various devices, describes the 
Rover user interface screens and dialog boxes, and explains how to use the software features.

Warnings, Cautions, and Notices

Safety advisories appear throughout this manual as required. Your personal safety and the proper 
operation of this machine depend upon the strict observance of these precautions.

The three types of advisories are defined as follows:

WARNING Indicates a potentially hazardous situation which, if not avoided, could result in 
death or serious injury.

CAUTIONs
Indicates a potentially hazardous situation which, if not avoided, could result in 
minor or moderate injury. It could also be used to alert against unsafe practices.

NOTICE
Indicates a situation that could result in equipment or property-damage only 
accidents.

WARNING

Proper Field Wiring and Grounding Required!

Failure to follow code could result in death or serious injury. All field wiring MUST be 
performed by qualified personnel. Improperly installed and grounded field wiring poses FIRE 
and ELECTROCUTION hazards. To avoid these hazards, you MUST follow requirements for field 
wiring installation and grounding as described in NEC and your local/state electrical codes. 
Failure to follow code could result in death or serious injury. 

WARNING

Personal Protective Equipment (PPE) Required!

Installing/servicing this unit could result in exposure to electrical, mechanical and chemical 
hazards.

• Before installing/servicing this unit, technicians MUST put on all PPE required for the work 

being undertaken (Examples; cut resistant gloves/sleeves, butyl gloves, safety glasses, hard 

hat/bump cap, fall protection, electrical PPE and arc flash clothing). ALWAYS refer to 

appropriate Material Safety Data Sheets (MSDS)/Safety Data Sheets (SDS) and OSHA 

guidelines for proper PPE.

• When working with or around hazardous chemicals, ALWAYS refer to the appropriate MSDS/

SDS and OSHA/GHS (Global Harmonized System of Classification and Labelling of 

Chemicals) guidelines for information on allowable personal exposure levels, proper 

respiratory protection and handling instructions.

• If there is a risk of energized electrical contact, arc, or flash, technicians MUST put on all PPE 

in accordance with OSHA, NFPA 70E, or other country-specific requirements for arc flash 

protection, PRIOR to servicing the unit. NEVER PERFORM ANY SWITCHING, 

DISCONNECTING, OR VOLTAGE TESTING WITHOUT PROPER ELECTRICAL PPE AND ARC 

FLASH CLOTHING. ENSURE ELECTRICAL METERS AND EQUIPMENT ARE PROPERLY RATED 

FOR INTENDED VOLTAGE.

Failure to follow instructions could result in death or serious injury.
© 2020 Trane  EMTX-SVX01M-EN



Introduction
Copyright

This document and the information in it are the property of Trane, and may not be used or 
reproduced in whole or in part without written permission. Trane reserves the right to revise this 
publication at any time, and to make changes to its content without obligation to notify any person 
of such revision or change.

Trademarks

All trademarks referenced in this document are the trademarks of their respective owners. 

Revision History

• Updated for new branding
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Rover Installation

This chapter:

• Lists the minimum requirements for your laptop PC

• Shows where to find instructions for installing Rover

• Provides a list of the components that ship with Rover

Laptop Requirements

Your laptop must meet the following hardware and software requirements to successfully run 
Rover.

Note: Rover is designed and validated for this minimum laptop configuration. Any variation from 
this configuration may have different results. Therefore, support for Rover is limited to only 
those laptops with the configuration previously specified.Installation Instructions

To install Rover, follow the instructions in Installing Rover Service Tool Version 7.2 X39641065-01. 
You can find a hard copy of this document in the Rover package and an electronic copy on the Rover 
installation USB flash drive. 

The installation sheet includes instructions on how to:

• Install Rover components from the product USB flash drive.

Note: The product USB flash drive should only be used to install Rover.

• Initialize the USB 2.0 network interface adapter

• Verify network communications

• Troubleshoot your PC

• 1 GB RAM (minimum) • An available USB 2.0 port

• 1024 x 768 screen resolution

• Ethernet 10/100 LAN card

• Windows 7 Enterprise or Professional or 
Windows 8.1 operating system (32-bit or 64-bit)

• Microsoft .NET Framework 3.5
EMTX-SVX01M-EN 7



Rover Components

Check to make sure that the Rover package you ordered contains the appropriate parts shown in 
Table 1. The software tools available with each package are listed in Table 2, p. 9. 

Table 1. Rover components

Part number Rover package Components
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X13651500-01 Complete toolkit (Comm4 and LonTalk software 
and hardware)        

4020 1196 Complete toolkit (Comm4 and LonTalk software) 
X13651501-01 Comm4 software and hardware     
4020 1191 Comm4 software 
X13651499-01 LonTalk software and hardware       
4020 1121 LonTalk software 
X13651502-01 LonTalk configuration-only software and 

hardware       
4020 1192 LonTalk configuration-only software 
X13651503-01 Air and water balance option        
4950 1198 Test and balance software 
4020 1199 Software upgrade 
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About Rover

The Rover service tool includes the following applications:

• Rover Comm4 service tool

• Rover LonTalk™ service tool

• Rover LonTalk configuration-only service tool

• Configuration Builder for offline editing of Tracer™ MP580/581 controllers

• Air and Water Balancing tool

• Flash Download Wizard

Rover is available in several packages so that you can order the software and hardware that you 
need. Table 2 lists the software tools available with each package. Table 1, p. 8 lists the available 
packages and shows their hardware components. 

Table 2. Software tools of the Rover packages
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Complete toolkit package      

LonTalk package     

LonTalk configuration-only package  

Comm4 package 

Test and balance package  

Software upgrade package1      
1 Use this package to upgrade previously registered components of Rover Version 6.0 (to include adding new software 

tools, such as the air and water balancing tool, to the appropriate packages).
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About Rover
Devices and Plug-ins

Rover supports certain Comm4 and LonTalk devices. A device is any controller that uses either 
Comm4 or LonTalk. A supported device is one that can be configured through Rover. Rover 
communicates with supported LonTalk devices through software modules called plug-ins. Each 
device and revision of a device requires its own plug-in for Rover to support it. For more 
information on supported devices and plug-ins, see “Device Plug-ins,” p. 60. Comm4 devices do 
not require plug-ins.

Rover Comm4

Rover Comm4 is an optional software tool that you can purchase as part of the Rover service 
software. Rover Comm4 is a software application for monitoring, configuring, and testing VAV II/
III/IV controllers and the terminal unit controller (TUC) on Comm4 links. Rover Comm4 replaces the 
EveryWare™ service software. 

Rover LonTalk

Rover LonTalk is a complete solution for monitoring, configuring, and testing Tracer controllers that 
use LonTalk communications. With Rover installed on your laptop PC, you can set up and configure 
stand-alone or networked unit controllers, then test and monitor their activity. Rover can 
communicate with any LonTalk device on a single communications link.

Rover LonTalk will help you:

• View the operating status of a device

• Monitor a device

• Identify and clear device diagnostics

• Change the device configuration

• Edit setpoints

• Exchange information between two or more devices

• Save and restore device configuration information

• Use the built-in utilities to manage devices and groups

Rover LonTalk Configuration-only

The Rover LonTalk configuration-only software runs only in the passive mode. This means that you 
can configure setpoints and other controller parameters but cannot create bindings or set up peer-
to-peer networks. All other Rover LonTalk features are available.

Other Tools

For information about the other software tools, refer to “Other Rover Software Tools,” p. 56
10  EMTX-SVX01M-EN



Connecting to LonTalk Links

This chapter shows how to connect Rover to a LonTalk device or network. 

Connecting a Communication Key

Most Tracer controllers have built-in communications capability, but the Tracer ZN010 does not. To 
connect to a Tracer ZN010, you must first install the communication key (Figure 1). Two 
communication keys are included with the Rover LonTalk hardware package.

NOTICE

Avoid Communication Key Damage

You must power down the Tracer ZN010 to install or remove the communication key. Failure to 
do so may damage the communication key.

Figure 1. Connecting the communication key to the controller
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Connecting Rover to a Device

You can use three methods to connect to Trane devices using LonTalk technology:

• Connect Rover to a zone temperature sensor communications jack that is connected to LonTalk 
devices with Comm wire

• Connect Rover to a LonTalk device using alligator clips

• Connect Rover to a LonTalk device using the quick connect adapter

Connecting to a Zone Sensor

The zone temperature sensor must be connected to the LonTalk link that contains the devices you 
want to configure.

To connect Rover to a zone temperature sensor:

1. Connect the supplied USB cable between the PC and the USB LonTalk adapter (Figure 2).

2. Connect the USB cable adapter to the USB LonTalk adapter. The adapter should click easily into 
the card. If you have to use force, the adapter may be upside down.

3. Connect the RJ11 plug on the other end of the USB 2.0 cable adapter to the RJ11 jack on the zone 
temperature sensor.

4. Test the communications link. Refer to “Connecting to a Tracer SC+ with an Echelon UC60 Using 
the LonTalk Interface Adapter,” p. 16.

Figure 2. Connecting Rover to zone temperature sensor
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Connecting Rover to a Device
Connecting Using Alligator Clips

To connect Rover to a device using alligator clips:

1. Connect the supplied USB cable between the PC and the USB LonTalk adapter (Figure 3).

2. Connect the USB cable adapter to the USB LonTalk adapter. The adapter should click easily into 
the card. If you have to use force, the adapter may be upside down.

3. Connect the RJ11 plug on the other end of the cable adapter to the RJ11 jack on the protection 
module.

4. Clip the alligator clips on the protection module to the device communications terminals (or 
connect to the communications link at another location). The link is not polarity sensitive.

5. Test the communications link. Refer to “Connecting to a Tracer SC+ with an Echelon UC60 Using 
the LonTalk Interface Adapter,” p. 16.

Figure 3. Connecting Rover to a device using alligator clips
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Connecting Rover to a Device
Connecting to a System Controller Using the LonTalk Interface Adapter

The procedures in this section explain how to attach the LonTalk Interface Adapter to a Tracer SC 
or to a Tracer SC+ with an Echelon U60 module, and connect Rover to the Tracer SC or Tracer SC+.

To connect Rover to a Tracer SC using the provided adapter (refer to Figure 4, p. 15):

1. Unplug the terminal block from the lower Lon Link on the Tracer SC.

Note: The Rover LonTalk Adapter will only fit into the lower Lon Link on the Tracer SC. 
Therefore, reserve the lower Lon Link for the adapter and do not connect the LonTalk 
network wiring to this terminal. Instead, wire the LonTalk network link to the upper Lon 
Link terminal. If the Tracer SC is terminated at the end of the LonTalk network link, there 
will only be one set of wires connected on the upper terminal block. However, if the 
Tracer SC is installed in the middle of the LonTalk network link, there will be two sets of 
wires to connect. In this case, gang two wires under each terminal of the upper Lon Link 
terminal block instead of using both the upper and lower Lon Link terminal blocks. If 
using both the upper and lower Lon Link terminals for network wiring, refer to the 
Alternate Wiring section below.

2. Plug the supplied LonTalk interface adapter into the location where the terminal block was 
removed.

3. Plug the terminal block, removed in the first step, into the top of the LonTalk interface adapter.

4. Connect the supplied USB cable between the PC and the USB LonTalk adapter (as shown in 
Figure 3, p. 13).

5. Connect the USB cable adapter to the USB LonTalk adapter (as shown in Figure 3, p. 13). The 
adapter should click easily into the card. If you have to use force, the adapter may be upside 
down.

6. Connect the RJ11 plug on the other end of the cable adapter to the RJ11 jack on the LonTalk 
interface adapter on the Tracer SC.

7. Test the communications link. Refer to “Connecting to a Tracer SC+ with an Echelon UC60 Using 
the LonTalk Interface Adapter,” p. 16.

Alternate Wiring

In cases where the LonTalk network wiring uses both the upper and lower terminals, the technician 
will have to break the communication on the link in order to insert the LonTalk interface adapter 
into the lower Lon Link terminal. 

Important: Minimize the time the LonTalk link is disconnected from the Tracer SC so the 
disruption doesn’t generate entries in the Event Log (as early as 90 seconds), or 
cause commands to be lost on the link. 

Be aware of the following issues when disrupting the LonTalk link to insert the LonTalk interface 
adapter:

• While the LonTalk Link is disconnected, the Tracer SC will be unable to read/write equipment-
resident data. Any Tracer SC TGP2 routines that are looking for equipment-resident data will 
not react to changes until the LonTalk Link is reconnected.

• Some commands issued while communication is disrupted, will not be sent to the devices. 

• If the LonTalk link is disconnected for longer than 15 minutes, the LonTalk devices will revert to 
using their default, standalone settings.

• Disconnecting and reconnecting the LonTalk link to insert the interface adapter, while in the 
process of troubleshooting a LonTalk communication problem, may cause unexpected changes 
in the link and complicate the troubleshooting task.
14  EMTX-SVX01M-EN



Connecting Rover to a Device
Connecting Using a Quick-connect Adapter 

To connect Rover using a quick-connect adapter:

1. Connect the supplied USB cable between the PC and the USB LonTalk adapter (Figure 5, p. 16).

2. Connect the USB 2.0 cable adapter to the USB LonTalk adapter. The adapter should click easily 
into the card. If you have to use force, the adapter may be upside down.

3. Connect the RJ11 plug on the other end of the network interface cable to the RJ11 jack on the 
protection module.

4. Connect the other end of the quick connect adapter to the device communications terminals, 
which are not polarity sensitive.

5. Test the communications link. Refer to “Connecting to a Tracer SC+ with an Echelon UC60 Using 
the LonTalk Interface Adapter,” p. 16.

Figure 4. Connecting Rover to a Tracer SC using the LonTalk interface adapter

Plug the Lon interface 
adapter into the 
lower Lon Link

Lower Lon Link

Upper Lon Link

Unplug the terminal 
block from the lower 
Lon Link and plug it 
into the Lon interface 
adapter
EMTX-SVX01M-EN 15



Connecting Rover to a Device
Connecting to a Tracer SC+ with an Echelon UC60 Using the LonTalk 

Interface Adapter

To connect Rover to a Tracer SC+ Echelon UC60 using the LonTalk interface:

1. Unplug the terminal block (orange connector) from the Echelon U60.

2. Plug the supplied LonTalk interface adapter into the location where the terminal block was 
removed.

3. Plug the terminal block that you removed in Step 1 into the top of the LonTalk interface adapter.

4. Connect the supplied USB cable between the PC and the USB LonTalk adapter.

5. Connect the USB cable adapter to the USB LonTalk adapter. The adapter should click easily into 
the card. If you have to use force, the adapter may be upside down.

6. Connect the RJ11 plug on the other end of the cable adapter to the RJ11 jack on the LonTalk 
interface adapter on the Tracer SC+.

7. Test the communications link. 

Figure 5. Connecting Rover to a device using a quick-connect adapter
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Connecting Rover to a Device
Figure 6. Tracer SC+ and Echelon UC60 with LonTalk Adapter

Verifying Network Communications

This section explains how to verify communication using either a USB Adapter or a PCMCIA card.

Verifying Using a USB Adapter

To verify communications:

1. Double-click the Start icon and then click the Control Panel link to display the Control Panel 
window.

2. Double-click the Lonworks Interfaces icon to display the LonWorks Interfaces dialog box. 
Then, click the USB node, select the required interface, and click Test.

3. Click Comm and a message displays stating "Now waiting for a service pin message" and is 
displayed in the LonWorks Interfaces Diagnostics comment box.

4. Press the service pin button of a connected device on the link. The Neuron ID of the selected 
device and a repeated message of "Ping Passed" are displayed in the LonWorks Interfaces 
Diagnostics comments box.

Echelon Adapter Tracer SC+

LonTalk 
Interface
Adapter

Comm Wire USB cable
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Connecting Rover to a Device
Figure 7. Ping Passed and Network Interface Node Status

Verifying Using a PCMCIA Card

To verify communications:

1. Click the Start icon at the lower left of the Windows desktop.

2. Click the Control Panel text link to display the Control Panel window.

3. Double-click the LonWorks Plug ’n Play icon to display the LonWorks Plug ’n Play dialog box 
and then click Diagnostics to display the PCCLON1 Diagnostics dialog box (Figure 8).

4. Click the Comm button and a message displays stating that this procedure will configure the 
Network Interface.

5. Click Yes and the message Now waiting for a service pin message is displayed in the PCCLON1 
Diagnostics comment box.

6. Press the service pin button of a connected device on the link. The Neuron ID and Program ID 
of the selected device and a repeated message of Ping Passed are displayed in the PCCLON1 
Diagnostics comment box.

Figure 8. PCCLON1 Diagnostics
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Connecting Rover to a Device
7. Click the Quit button to stop pinging the node (Figure 9).

8. Click Test to verify the node state is configured. If configured, the message Node State: 
Configured displays.

9. Click OK to close the PCCLON1 Diagnostics dialog box.

10. Click OK to close the Lonworks Plug ’n Play dialog box.

11. Close the Control Panel window.

Figure 9. Neuron ID, Program ID, Ping Passed, and Node State: Configured
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Connecting Rover to a Device
Connecting to a System Controller LON Link Using Remote Connection

Rover has system controller connection capability, which makes it possible for you to access, 
display, and configure LON devices on a system controller LON link without being physically 
present at the building site. You can connect to LON network devices through a system controller 
by specifying a system controller's IP address or DNS name defined as a persistent facility or 
specified on a one-time basis. You can also import system controller information (facilities) that you 
have defined on the Tracer TU Startup Task Panel. 

You can use the Rover Interface Connection dialog box to initiate a connection to a system 
controller LON link on various facilities. See the Rover Comm5 Help for a description of the Rover 
Interface Connection dialog box. 

Notes:

• System Controller firmware 4.2 or higher along with Tracer TU V9.0 are the minimum product 
levels required to use this remote connection feature.

• Display the Rover Interface Connection dialog box by disconnecting your USB LON dongle 
before launching Rover , by selecting Group > Connect/Disconnect, or by selecting Tools 
> Options > Advanced and then selecting Connect to system controller on the Network 
Interface list box.

• Rover does not support USB connections to the system controller.

Figure 10. The Rover Interface Connection dialog box

• Local Hardware Connections

Select this radio button to connect to a device on the local network using the dongle.

• Remote Connection

Select this radio button to define persistent facilities and their LON network devices. The facility 
information you add for each system controller is displayed on the list for repeated use when 
connecting to devices on a Tracer SC LON network.

• One-Time Remote SC (Manual IP/DNS)

Select this radio button to enter an IP address or DNS name on a one-time basis.

 

Click Modify to 
edit system 
controller connection 
information.

Click Add to add a 
new system 
controller.

Click Delete to 
delete a system 
controller.

Click Import to import 
system controller in-
formation from the 
Tracer TU Startup Task 
Panel
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Connecting Rover to a Device
• Connect

Click to connect to the Tracer SC you have selected from your listed facilities or that you have 
entered on a one-time basis. 

• Close

Click to discontinue connection activities and close the dialog box.

Connecting to a Tracer System Controller with Multiple LON links

Figure 11. Rover Passthrough Links

1. When connecting to a system controller with multiple LON links, Rover will give you an option 
to choose the LON link it discovered.

2. Select the LON link to discover and click OK.

Adding a System Controller to the Rover Interface Connection Dialog Box

You can add persistent facility information for a particular system controller to the Rover Interface 
Connection dialog box.

1. Start Rover and connect to a system controller hrough a LAN or using an Ethernet cable.

2. Select LonTalk Service Tool to display the Rover Interface Connection dialog box.

3. Click Add to display the Add system controller dialog box.

4. Enter the Connection Name and IP Address or System Controller Hostname.

5. (Optional) Enter a description if that will be helpful in identifying the device.

6. Click Save.

Importing Facilities from Tracer TU to Rover 

You can import Tracer SC (facility) information (the Name and IP Address or DNS Name) that is 
defined on the Tracer TU Startup Task Panel. The imported facility information is added to the list 
on the Rover Interface Connection dialog box.
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Note: You cannot import or connect to facilities having names containing non-English characters. 
However, you can recreate the facility name on the Add SC dialog box accessed using the 
Add button.

1. Start Rover and select LonTalk Service Tool to display the Rover Interface Connection dialog 
box.

2. Click Import to display the Import dialog box.

Rover automatically finds the facilities defined in Tracer TU and lists them on the Import dialog 
box grid.

3. Select the check box of each facility you want to import into Rover’s Interface Connection 
dialog box.

4. Click Import to bring the information for each facility into Rover.

Connecting to Different Tracer SC

When you complete work in one Tracer SC, you can connect to different Tracer SC by performing 
the following steps.

• Select Group > Connect/Disconnect.

OR

• Navigate to Tools > Options > Advanced and then select Connect to SC on the Network 
Interface drop-down list box.
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Using Rover Comm4
Using Rover Comm4

Rover Comm4 is an optional Rover application that replaces the EveryWare service software. It 
maintains all of the functionality of EveryWare with the added convenience of running in Windows.

With Rover Comm4, you can:

• Configure, monitor, and test VAV II/III/IV controllers and termincal unit controllers (TUC)

• Override VAV controllers and TUCs

• Save configuration files

• Perform offline editing

Operation Instructions

For instructions on how to use Rover Comm4, refer to the Rover Comm4 Online Help (click Contents 
and Index on the Help menu.)

Connection Instructions

For instructions on connecting your laptop PC to a Comm4 link, refer to Installing Rover Service 
Tool Version 7.2, X39641065-01. You can find a hard copy of this document in the Rover package and 
an electronic copy on the Rover Installation USB flash drive.

Power Requirements and Hardware Installation

Input Power

USB self power (500mA, SV)

Output Power

150mA, 5V power output for external devices requiring power

Hardware Installation

On the outside of the unit is a 4-pin DIP switch that is set to select the mode of operation. Set the 
DIP switch to accommodate your application for either an Comm4 or RS-232 as shown in Figure 12. 
After setting the DIP switch, plug in the adapter to the USB port to start the driver installation.

Figure 12. Mode block configuration settings
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Terminal Block Connection

Table 3 and Figure 13 below show connection to the terminal block on the Comm4 adapter. 

Table 3. Pin definitions on the terminal block

Pin # Comm4 Device

1 Data-(A)

2 Data+(B)

5 +5V

6 GND

Figure 13. Comm4 terminal block connections
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Using Rover LonTalk
Using Rover LonTalk

This chapter shows how to start Rover LonTalk, describes the screen layout and conventions, and 
how to access the Online Help system.

Starting Rover LonTalk

Once you have Rover installed and connected, you are ready to start the application.

To start Rover:

1. Double-click the Rover icon on your Windows desktop to display the Rover Service Tool startup 
menu (Figure 14, p. 25).

2. Click the button to start either LonTalk Service Tool or the LonTalk Configuration Only 
Service Tool. The Rover application window displays (Figure 15).

During startup, Rover looks for a communications link and if it finds one, it fills the Active Group 
tree with any communicating devices on the communications link. If no link is found or no devices 
are found on the link, the Active Group tree contains only the Active Group icon with no devices 
listed.

Figure 14. Rover startup menu

LonTalk configuration-only tool

 LonTalk service tool
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Using Rover LonTalk
Screen Conventions

Rover screen conventions include the Active Group tree, the workspace, the menu bar, shortcut 
menus, and the status bar.

Active Group Tree

The Active Group tree is an expandable list that displays all the devices on the communications link 
(Figure 16). Each device is listed by name under the appropriate device type icon. The All Devices 
icon displays all the devices without separation by type.

The icon for each device changes to reflect its current communications status (online, offline, 
unconfigured, or not communicating). Table 4 shows the icons that may appear in the tree.

Figure 15. Rover startup menu

Menu bar

Active 
Group tree

Workspace

Status bar

Figure 16. Active Group tree
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Using Rover LonTalk
Workspace

The workspace is the area of the application window to the right of the Active Group tree. As you 
click the different icons on the Active Group tree, Rover displays group or device information 
depending on the item selected in the tree.

The workspace consists of the following three main views:

• Active Group View: displays summary information for all the devices in the active group 
when the Active Group icon is selected in the Active Group tree (Figure 17). The view also 
displays the total number of devices on the active link.

In the Active Group tree, click the Active Group icon to access the Active Group View. Double-
click a device in the workspace to select that device in the Active Group tree and to view its 
status in the workspace.

Table 4. Active Group tree icons

Icon Description Meaning

Group selected Indicates that the Active Group is 
selected. Double-click the icon to collapse 
the active group.

Device type Indicates an unselected set of devices of 
the same type within the active group. 
Double-click the icon to expand the 
device type.

Device type selected Indicates a selected set of devices of the 
same type within the active group. 
Double-click the icon to collapse the 
device type.

Device online Indicates a device is configured and is 
communicating normally on the link.

Device offline Indicates a device that is configured but 
that the technician has directed to stop 
communicating on the link by setting it to 
offline.

Device 
unconfigured

Indicates a device that has not been 
configured and is communicating on the 
link.

Device not 
communicating

Indicates a device that was 
communicating but is no longer 
communicating on the link.
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Using Rover LonTalk
• Device Type View: displays summary information for all the devices in the active group 
(Figure 18). This view also displays the total number of devices of that type on the active link. 
In the Active Group tree, click a device type icon and the double-click a device in the workspace 
to select and view the device status.

• Active Device View: displays tabs and command buttons for viewing and changing data 
related to the selected device (Figure 19). This screen displays only functions and information 
supported by the selected device. 

In the Active Group tree, click a device icon to access the Active Device View.

Figure 17. Active Group View

Figure 18. Device Type View for the active group
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Using Rover LonTalk
Menu Bar

The menu bar at the top of the Rover window contains drop-down menus for working with groups, 
devices, optional views, Rover tools, and Rover help (Figure 20). The Group menu has commands 
for working with active groups. The Device menu has commands for working with active devices. 
The View menu provides viewing options. The Tools menu provides options you can customize. 
The Help menu offers online Help and general Rover information.

Shortcut Menus

To view a shortcut menu, use your right mouse button to click any icon in the Active Group tree 
(Figure 21). Shortcut menus contain common commands you can use on the item you clicked. For 
example, right-click a device in the Active Group tree and choose Wink from the device shortcut 
menu to wink the device.

Figure 19. Active Device View

Figure 20. Rover menu bar
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Status Bar

The status bar appears at the bottom of the Rover window (Figure 22, p. 30). As you work with 
groups and devices, the status bar displays the progress of actions that Rover is running and the 
communications state of your laptop PC. The status bar shows the following items:

• Rover Status: Text that describes what action Rover is currently doing, such as Searching for 
Servers

• Rover Status: Ready when Rover is waiting for a command

• Discovery DSN: Displays the domain on which Rover will discover the network.

• Installation DSN: Displays the domain and subnet on which Rover will install devices on the 
network.

• Tool Mode: Current operating mode (Active, Passive, or Server-Connected)

• Link Status: USB adapter status, such as Network Services Ready

• Link Status: Text that describes actions occurring on the communications link, such as Starting 
Discovery and Querying for BAS

Note: If you double-click on either the Discovery DSN or Installation DSN section of the status bar, 
it launches the Device Options window.

Accessing the Online Help

Rover includes Online Help for each screen and dialog box. You can access the online Help in two 
ways:

• On the Help menu, click Contents and Index to access the Online Help contents.

• Press F1 or the Help button for information about the current screen or dialog box.

Figure 21. Shortcut menu

Figure 22. Rover status bar with good communications status

Rover Status Discovery DSN Installation DSN Tool Mode Link Status
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Operating Modes
Operating Modes

Rover LonTalk can operate in one of three modes:

• Passive

• Active

• Server-connected (active)

You can see Rover’s current operating mode on the status bar at the bottom of the Rover interface.

Passive Mode

In the passive mode, you can use Rover to configure only controllers. You cannot use Rover to 
manage networks or create bindings. The passive mode is the safest (default) mode of operation. 
Use the passive mode on:

• Third-party (non-Trane) networks

• Trane networks with Tracker controllers that have not yet been installed

• Trane networks with a BCU or Tracker controller to achieve faster performance

Active Mode

In the active mode, you can use Rover to create bindings and clean up LonTalk links. Use the active 
mode on Trane peer-to-peer networks. Do Not enter the active mode on third-party networks or 
on Trane networks with Tracker controllers that have not yet been installed (see “Considerations 
for Tracker Links,” p. 33). 

Server-connected (Active) Mode

The server-connected mode is a type of active mode in which Rover interacts seamlessly with Trane 
servers. In this mode, you can use Rover to create bindings. Rover can enter the server-connected 
mode when another server, such as a BCU or Tracker controller, is on the link. Rover cannot enter 
the server-connected mode on third-party networks. Tracer SC is not a Trane server; therefore, the 
Tracer SC will display and be treated as any other LonTalk device.

Note: When you choose to enter the active mode, Rover determines whether to enter the active 
mode or the server-connected mode.

Changing Operating Modes

For faster performance, do not switch to the active mode unless you need to create bindings. 
Changing modes also requires Rover to rediscover the link, which may take some time depending 
on the size of the link. 

To change operating modes:

• On the Group menu, point to Tool Mode, then click the mode you wish to enter.

If Rover detects a server when entering the active mode, Rover asks if you want to connect to 
the server (to enter the server-connected mode). If Rover does not detect a server, it enters the 
active mode.

Important: Do not enter the active mode on third-party networks or on Trane networks with 
Tracker controllers that have not yet been installed. In addition, do not enter the 
active mode on networks with a server that has been installed but which is not 
currently operating. In these situations, Rover could change the existing network 
information (requiring reconfiguration of the network), and bindings could be lost.
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Operating Modes
Changing Installation and Discovery Domains

Trane devices are installed by Tracker and the Tracer Summit BCU on the zero-length domain (for 
discovery) and domain 11 (for communications) of the LonTalk network. Rover has the ability to 
discover devices on non-standard Trane domains, and install devices on non-standard Trane 
domains and subnets. 

Note: On sites containing Tracker or BCU devices, always use Trane’s standard domains and 
subnets.

Refer to “Changing the Network Interface,” p. 50 for detailed information on changing Rover’s 
installation and discovery domain.

Note: Tracer SC controllers, when shipped from the factory, will assign themselves a DSN ID 
similar to the way Trackers and BCUs have in the past. Therefore, if installing a Tracer SC 
on a Trane domain and subnet, it is not necessary to have the Tracer SC on the link when 
configuring the network with the Rover Service Tool.

Changing the Existing Installation Network Domain

The Rover Service Tool 7 has the capability to reassign an existing installation domain and subnet 
to a new installation domain and subnet. This function is only available in the Rover Service Tool. 
This will be used only occasionally where existing devices on the network need to moved to a new 
network domain or subnet. This function is added to facilitate moving multiple devices at one time 
instead of moving them one at a time using the domain entry function. 

NOTICE

Changing the domain address of a device communicating on the link 

will remove any bindings previously created for that device. It will also 

cause that device to stop communicating on the link.

This feature is not available in the server-connected mode and should not be used on Tracker and 
Tracer Summit sites. 

Tracer SCs with their domain ID changed in this fashion must have all their equipment deleted, 
rediscovered, and then re-installed in Tracer SC.

To change multiple devices to a new network domain:

1. Set the discovery domain to the existing network configuration.

2. Discover the link.

3. Set the installation domain and subnet to the new domain and subnet.

4. From the Group menu or right click on any device type node in the Active Group Tree and select 
Install (not available when individual devices are selected in the tree). This will move all 
discovered devices on the link, not just the device types selected.

5. A warning appears (Figure 23). 

6. Click Yes.
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Additional Information

Considerations for BCU Links

For LonTalk links managed by a BCU, you can place Rover in the active mode (to create bindings) 
either before or after the BCU is installed on the link. When entering the active mode before the BCU 
is on the link, make sure that you later choose to add to or discover an existing link from Site 
Configuration in the Tracer Summit software then clear RAM on the BCU. If you choose to create 
a new link, any bindings that you have created will be lost.

Considerations for Tracker Links

For LonTalk links managed by a Tracker controller, enter the active mode only after the Tracker 
controller is installed and operating on the link. The Tracker controller configures the network when 
it first becomes active (or is restored) on the link, removing any existing bindings that you have 
created. 

Considerations for Third-party Links

Use only the passive mode on third-party (non-Trane) networks. In the active mode, Rover may 
cause problems on third-party networks. Use the third-party service tool to create bindings. 

Considerations for Tracer SC

Trane recommends installing Tracer SC and LonTalk devices connected to the Tracer SC on Trane’s 
typical domain and subnet. However, because Tracer SC is not a network manager, it can be 
installed on different domains and subnets. If installing a Tracer SC on a non-Trane domain, the 
Tracer SC, and any other LonTalk unit controller that shares the same network, needs to be 
configured for the new domain using the Rover service tool.

Note: Tracer SC controllers, when shipped from the factory, will assign themselves a DSN ID 
similar to the way Trackers and BCUs have in the past. Therefore, if installing a Tracer SC 
on a Trane domain and subnet, it is not necessary to have the Tracer SC on the link when 
configuring the network with the Rover Service Tool.

Figure 23. Group Install Warning
EMTX-SVX01M-EN 33



Working with the Active Group

This chapter includes instructions on working with devices communicating on the active link. After 
selecting a device in the Active Group tree, the menu commands and buttons that are available 
depend on the type of device and its communications state. 

Viewing the Active Group Summary

The active group summary (Figure 24) includes information for all the devices in the active group, 
including device name, device type, program ID, Neuron ID, and device status. The summary also 
displays the total number of devices on the active link.

To view a summary of the active group: 

In the Active Group tree, click the Active Group icon. The workspace displays device information 
for the active group.

Figure 24. Active Group View
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Viewing Device Types
Viewing Device Types

The Device Type View displays information, such as revision number, Neuron ID, and 
communications status, about the devices of that type in the active group. For Trane devices, the 
device type name is displayed in the tree. For other devices, the device type is read from the 
program ID self-documentation.

To view device types:

In the Active Group tree, click a device type icon. The workspace displays device information for 
the selected device type.

Viewing Device Status

The device status includes device specific as well as general information, such as Neuron ID, device 
state, manufacturer ID, and the device self-documentation information. 

To view a device status:

1. In the Active Group tree, click the device you want to view. The Active Device View appears in 
the workspace (Figure 19, p. 29).

2. Click any of the available tabs to view status information about the selected device (see 
Figure 25).

Note: The number of tabs available in the device status area depends on whether the Rover 
service tool has a plug-in to support the device. If only a General tab is provided and the 
manufacturer ID is Trane, a plug-in may be available for additional functionality. For more 
information, see “Device Plug-ins,” p. 60

Figure 25. Device status
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Resetting a Diagnostic

When Rover detects a problem with a device, an explanatory error message appears in the 
Diagnostic area of the device status Unit tab. When no diagnostic messages are active, the 
Diagnostic area shows a status of Normal.

Note: Only latching diagnostics need to be reset manually. Non-latching diagnostics reset 
automatically when the problem at the device is corrected.

To reset a diagnostic:

1. In the Active Group tree, click the device you want to view to display the Active Device View in 
the workspace.

2. Click the Unit tab for a listing of existing diagnostics displayed in the Diagnostic area.

3. If the diagnostic is a latching diagnostic, correct the problem at the device.

4. Click Reset Diagnostic and the diagnostic clears only if the problem has been solved at the 
device.
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Winking a Device

Winking a device causes the status LED on the selected device to blink for approximately 10 
seconds. This command is useful when a discrepancy in device names exists in a group. For 
example, Room 100 feels warm, but Rover displays 62ºF for the zone. As a part of the 
troubleshooting process, a technician can choose Wink from the Device menu while another 
technician verifies the device location. “Setting the Auto-wink Option,” p. 49 to set Rover to 
automatically wink a device when you press the service pin button on that device.

To wink a device:

1. In the Active Group tree, click the device you want to wink.

2. From the Device menu, choose Wink. The status LED on the selected device begins to blink.

Note: If the status LED does not blink, the device may not be the one you selected in the tree, the 
device may not be communicating, or the network communications card may not be 
installed correctly.

Identifying a Device

Use this command to identify which device in the Active Group tree represents the physical device 
you are working on. Rover selects the device in the Active Group tree and displays its status in the 
workspace. “Setting the Auto-identify Option,” p. 49 to set Rover to automatically identify a device 
when you press the service pin button on that device.

To identify a device in the active group:

1. Click any icon in the Active Group tree.

2. Select Device>Identify from the main menu. You are prompted to press the service pin of the 
device you want to identify or to cancel the identify.

The Identify command is available only if an icon in the Active Group tree is selected.

3. Press the service pin button on the device when prompted. Rover selects the device in the Active 
Group tree and the device status appears in the workspace.

If it is difficult to reach the service pin button and the device is connected to a zone temperature 
sensor, you can press the On button on the sensor. Press and hold the button for 10 seconds 
to initiate the identify.

Changing the Device Domain Entry

Use the Domain Entry dialog to view and change the domain addresses for individual devices. 

NOTICE

Changing the domain address of a device communicating on the link 

will remove any bindings previously created for that device. It will also 

cause that device to stop communicating on the link.

When you change the domain entry for a device, a warning appears (see Figure 26) reminding you 
to confirm your changes with the network manager.
EMTX-SVX01M-EN 37



Winking a Device
To change a device domain address:

1. The Domain Entry dialog is available by right clicking on a device in the Active Group tree on 
the left and selecting Domain Entry..., or by selecting Device>Domain Entry... from the 
main menu.

2. The Domain Entry dialog appears (refer to Figure 27). To disable one or both DSN (A or B), 
unselect the Enabled: check box. Both of these check boxes are typically selected. 
Communication occurs on DSN (A) and discovery occurs on DSN (B).

3. Define the domain length by selecting the appropriate number after Domain Length. Trane 
typically installs devices on the 1-byte length (1) domain for DSN (A) and zero-length domain 
(0) for DSN (B).

4. Define the Domain ID (hex). This is the number (it is hexidecimal number) that identifies the 
main LonTalk link on which devices reside for communication or discovery. When 0 is selected 
for the length, the domain field is disabled. However, Rover can now install and discover 
devices on any domain. The domain number you can use depends on the Domain Length 
selected. 

Figure 26. Domain Entry Warning

Figure 27. Domain Entry dialog
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The following list defines the limitations:

• 1-byte domain length addresses: 00 to FF

• 3-byte domain length addresses: 000000 to FFFFFF

• 6-byte domain length addresses: 000000000000 to FFFFFFFFFFFF

5. Define the Subnet ID. Each device in the domain must have the same subnet number to 
communicate with each other. Numbers from 1 to 255 are valid.

6. Define the Node ID. Each device on the subnet must have a unique node number. Numbers 
from 1 to 127 are valid. However, node addresses 126 and 127 are usually reserved for network 
tools, so do not assign those node numbers to devices.

7. Click Set.

Renaming a Device

If the device name is stored on the physical device, Rover adds the name to the group information 
when the device is added. Otherwise, Rover gives a default name (for example, RoverDev_7). You 
can rename supported devices to something more meaningful.

To rename a device:

1. In the Active Group tree, click the device you want to rename.

2. Select Device>Rename from the main menu to edit the device name.

If the selected device is not supported, Rename is not available on the Device menu.

3. Type the new name and press the Enter key. The name is changed.

Note: You may want to name the device by room or location.

Removing a Device

Use the Remove command if you need to remove a device permanently from the physical 
communications link. A removed device no longer appears in the Active Group tree and is not 
accessible in the active group. Using the Remove function instead of simply disconnecting the 
device from the link ensures that any network variable bindings with the device are cleared from 
the link prior to the device removal. This ensures that devices remaining on the link do not 
continue to attempt to share data with the removed device. 

Rover must be in the active mode to remove a device. If there is a BCU or other Trane server on 
the link, remove (or unassign) the device in the user interface (such as Tracer Summit) for the 
server.

To remove a device from the active group:

1. In the Active Group tree, click the device you want to remove.

2. From the Device menu, choose Remove. A message box appears prompting you to physically 
detach the device from the link.

3. Detach the physical device from the link.

4. Click OK. The device is removed from the Active Group tree.
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Adding a Device

When you start Rover, it automatically discovers communicating devices on the link and fills the 
Active Group tree with these devices. If you add a device to the link after startup, you can add the 
device to the active group.

To add a device:

1. From the Group menu, choose Discover. Any new devices on the link are added to the Active 
Group tree.

Troubleshooting a Device

Use the Troubleshooting menu items to identify communications problems with a device. 

Placing a Device Offline or Online

Placing a device online causes it to communicate normally on the physical link. When a device is 
offline, it stops responding to communications on the physical link. The device state becomes 
offline, and it remains ready for an online command. Rover must be in the active or server-
connected mode to place a device offline or online.

To place the device offline or online:

1. In the Active Group tree, click the device that you want to place offline or online.

2. From the Device menu, choose Troubleshoot to display the Troubleshoot submenu.

3. From the Troubleshoot submenu, choose the device state you want. The device state changes 
and its icon changes to show the state.

Resetting a Device

You can reset a device to restart the device processor.

To reset a device:

1. In the Active Group tree, click the device you want to reset.

2. From the Device menu, choose Troubleshoot to display the Troubleshoot submenu.

3. From the Troubleshoot submenu, choose Reset. The device is reset.

Testing a Device

Testing a device causes Rover to display a dialog box of link communications information. This 
information provides a mixture of device hardware, firmware, application, and network 
communications status data for the device. Look for the following troubleshooting clues:

• ROM software version

• Recent error 

• Cycle Redundancy Check (CRC) error 

• Timeouts 

• Rx buffer full 

• Node state 

• Lost messages 

• Missed messages
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To test a device:

1. In the Active Group tree, click the device you want to test.

2. From the Device menu, choose Troubleshoot to display the Troubleshoot submenu.

3. From the Troubleshoot submenu, choose Test. A dialog box displays the test results. 

4. Click Close.
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Configuring a Device

Device configuration is available only on certain Trane devices.

Viewing Device Configuration

You can view the configuration setup screen for certain Trane devices. The configuration includes 
information required for proper unit control.

To view device configuration:

1. In the Active Group tree, click the device you want to view. The Active Device View displays in 
the workspace.

2. Click Configuration in the Active Device View to display the Configuration dialog box 
(Figure 28).

3. Click Close.

Editing Device Configuration

You can change the controls for certain Trane devices by editing their configuration.

To edit device configuration:

1. In the Active Group tree, click the device you want to configure. The Active Device View displays 
in the workspace.

Figure 28. Device configuration
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2. Click Configuration in the Active Device View to display the Configuration dialog box 
(Figure 28, p. 42).

3. Make your changes to the device configuration.

Major configuration changes affecting the input/output assignments for the device cause the 
device to perform a reset, temporarily turning off the unit. Simple changes, such as setpoints, 
do not cause a reset.

If you decide not to use the changes you have entered, you can choose Upload from the 
Configuration menu. The current configuration values are uploaded from the device. You can 
also click Close to close the Configuration dialog box without saving any changes.

4. Click Download and a message box displays to confirm the download.

5. Click Yes. Rover downloads the configuration to the device.

6. Verify that these values are correct.

7. Click Close.

Saving a Configuration File

When you are satisfied with the changes you downloaded to a device and would like to use the 
same configuration for a different device, you can save the configuration and download it to 
another device by saving the configuration as a Rover Configuration File (RCF).

You can save unchanged configurations at any time, and you can save them anywhere you choose, 
including on disks. However, once you have made changes to a configuration file, you must first 
download the configuration to the device before you can save it. You can identify configuration files 
by the extension RCF, named for Rover configuration file.

Note: When you save, Rover always saves the configuration that was last downloaded to a device. 
For example, you might make a change to the setpoints and download the configuration to 
the device. Then you change the device configuration for binary output 6 and, from the File 
menu, choose Save. Because you did not download the change to the binary output 6 
configuration, this change is not saved in the configuration file.

To save a configuration file:

1. In the Active Group tree, click the device you want to configure and save. The Active Device 
View displays in the workspace.

2. Click Configuration in the Active Device View to display the Configuration dialog box.

3. If you make changes to the device configuration, click the Download button, then click Yes to 
confirm the download. Rover downloads the configuration to the device.

4. From the File menu in the Configuration dialog box, choose Save.

5. Select the location and type a file name in the Save dialog box. The default location is 
Rover\Configs. You may want to use this directory as a convenient place to save all your RCF 
files.

6. Click Save. The configuration file (RCF) is saved in the location you specified.

7. Click Close.

Downloading a Saved Configuration File

You can open and download a saved Rover configuration file to another device.

To download a saved configuration file:

1. In the Active Group tree, click the device you want to configure with a saved file. The Active 
Device View displays in the workspace.

2. Click Configuration in the Active Device View to display the Configuration dialog box.
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3. From the File menu, choose Open. 

4. Select the desired configuration file (RCF) and then click Open.

5. Click Download and a message box displays to confirm the download.

6. Click Yes. Rover downloads the configuration to the device.

7. Click Close.

Working with Additional Device Functions

Devices in the active group may have other functions in addition to status and configuration. You 
can access these functions with the command buttons on the right side of the workspace in the 
Active Device View.

For more information about the additional functions included with your device and about how to 
use these functions, use the What’s This? help in the function window or select the device topic in 
the Rover Help Contents.

This chapter includes instructions for working with network variable bindings, using Rover in 
Tracer Summit, and changing Rover options.

Network Variable Bindings

For more than one device to share data, such as zone temperature and setpoints, you can bind the 
network variables of several devices together. 

For example, a library has two fan coil units installed serving a common area. Each currently has 
its own unit-mounted sensor. The unit located next to an outdoor entrance can sense large 
temperature swings and ends up in an operating mode opposite that of the interior unit. By binding 
the two fan coils to a sensor mounted on a middle column, both units can share the zone 
temperature, setpoint, and fan selector data. The two units then coordinate their operating modes.

Note: You can bind network variables only when there is more than one device on the active link. 
Bindings made on Tracer ZN010s are lost when the communication key is removed.

Viewing Network Variable Bindings

To view network variable bindings:

1. Click any icon in the Active Group tree.

2. Choose Bindings to display the Network Variable Bindings Summary dialog box (Figure 29, 
p. 45). The Bindings command is available only if an icon in the Active Group tree is selected.

3. Click Close.
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Adding Network Variable Bindings

Rover must be in the active or server-connected mode to create bindings.

To add network variable bindings:

1. Click any icon in the Active Group tree.

2. From the Group menu, choose Bindings to display the Network Variable Bindings Summary 
dialog box (Figure 29).

The Bindings command is available only if an icon in the Active Group tree is selected.

3. Click Add... to display the Add Network Variable Bindings dialog box (Figure 30, p. 46).

Figure 29. Network Variable Bindings Summary
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4. From the Step 1 list, click a device to bind. This list contains all the devices on the active link.

5. From the Step 2 list, click the network variable you want to bind. This list contains all the output 
and input variables in the device you selected from the Step 1 list.

6. From the Step 3 list, click a device with which to bind. This list contains all communicating 
devices except the device selected from the Step 1 list.

7. From the Step 4 list, click a network variable with which to bind. This list contains variables 
common to the device you chose from the Step 3 list that are compatible with the variable you 
chose from the Step 2 list.

8. Click Bind to display the new binding appears in the Network Variable Bindings Summary 
dialog box (Figure 31, p. 47). Click Reset instead of Bind if you want to start over in setting the 
binding. No binding information is saved until you click Bind.

9. Click Close.

Figure 30. Add Network Variable Bindings
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Removing Network Variable Bindings

You can remove a network binding in the active group to stop the sharing of data between devices. 
Rover must be in the active or server-connected mode to remove bindings.

To remove network variable bindings:

1. Click any icon in the Active Group tree.

2. From the Group menu, choose Bindings to display the Network Variable Bindings Summary 
dialog box (Figure 29, p. 45).

The Bindings command is available only if an icon in the Active Group tree is selected.

3. Select the bindings you want to remove.

To select a single binding for removal, click one row. To select multiple bindings, click the first 
item, press and hold down the SHIFT key, then click the last item. 

4. Click Remove for a confirmation.

5. Click Remove and the bindings are removed from the active group.

You can also remove network variable bindings by selecting bindings and pressing the Delete 
key.

6. Click Close.

Using Rover in Tracer Summit

You can use the Rover LonTalk service tool within your Tracer Summit software to configure unit 
controllers. There are two ways to do this:

• Start the full version of Rover from the Tracer Summit™ Tools menu

• Open Rover configuration screens from Tracer Summit UCM editors

You can use Rover to configure all supported LonTalk controllers through Tracer Summit. The Rover 
LonTalk service tool must be purchased and installed separately from Tracer Summit. Tracer 
Summit Version 17.0 and Rover Version 6.0 or higher are required.

Note: All Rover functions are available except Rover Comm4, the Flash Download Wizard, and the 
Air and Water Balancing tool are not available through Tracer Summit.

Figure 31. Network Variable Bindings Summary with new binding
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Why Should I Use Rover in Tracer Summit?

By using Rover in Tracer Summit, you can:

• Configure and troubleshoot LonTalk controllers remotely on links with BCUs

• Create and view bindings remotely on links with BCUs

• Use Rover and Tracer Summit on the same computer

Who Can Access Rover From Tracer Summit?

The site security supervisor must grant access to appropriate technicians and operators before 
they can use Rover through Tracer Summit. There are two levels of access:

• Rover (Configuration Only), which offers access only to Rover configuration screens from UCM 
editors

• Rover (Full Access), which offers access to the full version of Rover, including the ability to 
create bindings between controllers

Note: An operator with full Rover access can configure all supported LonTalk controllers, even 
if that operator does not have access to certain types of LonTalk controllers in Tracer 
Summit.

Changing Rover Options

This section shows how to change the refresh rate, set the Auto-identify and Auto-wink options, 
select units of measurement, and change the network interface.

Changing the Device Status Refresh Rate

Rover automatically refreshes the selected device status in the Active Device View. 

Note: To manually refresh the device status in the workspace, press the F5 key.

To change the refresh rate:

1. From the Tools menu, choose Options (Figure 32).

Figure 32. Options
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2. Click the General tab.

3. Type a rate between 5 and 90 seconds in the Active device status refresh rate field. Type 
0 (zero) if you don’t want Rover to automatically refresh.

4. Click OK. The refresh rate is changed.

Setting the Auto-identify Option

You can use the Auto-identify option to identify a device in Rover. When the Auto-identify option 
is enabled, pressing the service pin button on a device selects that device in the Active Group tree.

Note: Do not enable the Auto-identify option during discovery, or every device found attempts to 
display its status in the workspace, slowing down the discovery process.

Do not enable the Auto-identify option when several people are working on the LonTalk link. 
A service pin press by anyone causes the focus on your laptop PC to shift to that device, 
which may cause you to lose any changes you were making.

To set the Auto-identify option:

1. From the Tools menu, choose Options (Figure 34, p. 51).

2. Click the General tab.

3. Click to select the Auto-identify check box.

4. Click OK. The option is set.

Setting the Auto-wink Option

When the Auto-wink option is activated, Rover automatically winks a device on the active link when 
you press the service pin button on that device. 

Use the Auto-wink option when you want to determine if a device is communicating on the link, 
but the device is a great distance from your laptop PC or is in a hard-to-reach area. If you press the 
service pin button on a device and the status LED blinks, you know the device is communicating. 
If the status LED does not blink, you know it’s not communicating and you can keep working on it 
without having to go back to your laptop PC.

To set the Auto-wink option:

1. From the Tools menu, choose Options (Figure 34, p. 51).

2. Click the General tab.

3. Click to select the Auto-wink check box.

4. Click OK. The option is set.

Selecting Units of Measurement

Rover can use inch-pound (I-P) units or the International System of Units (SI) for device plug-ins 
that support both types of units (see “Device Plug-ins,” p. 60, for more information on plug-ins). You 
can also select a mixture of I-P and SI units. I-P units include pounds and degrees Fahrenheit, and 
SI units include kilograms and degrees Celsius.

Selecting the International System of Units (SI) affects only device plug-ins that support SI. Rover 
will continue to use inch-pound units for plug-ins that do not support SI. If you do not select a 
system of measurement, Rover uses inch-pound units by default.

To select units of measurement:

1. From the Tools menu, choose Options (Figure 34, p. 51).

2. Click the Units tab (Figure 33, p. 50).
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3. In the Units of Measurement area, click to select the appropriate system of measurement.

Selecting Custom allows you to choose any of the supported units of measurement for each 
physical quantity used in Rover. To do this:

a. In the Physical Quantity list, click to select a physical quantity.

b. In the Units list, click to select the appropriate unit of measurement.

c. Repeat this process for each physical quantity as required.

4. Click OK.

Changing the Network Interface

LON (short for LonWorks) is a string used to prefix LonWorks network interfaces or ports, which are 
available once the LonWorks hardware is installed. Each piece of LonWorks hardware is assigned 
a unique port name that is used to identify and differentiate from LonWorks hardware. A Trane 
representative may ask you to change your network interface. 

To change the Rover network interface:

1. From the Tools menu, choose Options.

2. Click the Advanced tab (Figure 34, p. 51).

Figure 33. Units of measurement
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3. Enter the new network interface as instructed by a Trane representative.

4. Click OK. The interface is changed the next time Rover starts.

Figure 35 shows an option to change network interface on Comm error. This essentially 
provides the same mechanism as the drop down displayed in Figure 34.

Figure 34. Advanced options

Figure 35. Network interface error
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Defining the Discovery DSN

The discovery DSN (refer to Figure 34, p. 51) is available in both the Rover Service Tool and the 
Rover Configuration Only Service Tool modes. 

Setting the Domain DSN consists of selecting the Length of the domain and typing in the 
hexidecimal value for the domain. 

1. From the Tools menu, choose Options.

2. Click the Advanced tab (Figure 34, p. 51).

3. Define the domain length by selecting the appropriate number after Domain Length. Options 
for the length are 0, 1, 3, and 6. The number you select here dictates the length (in bytes) of the 
domain address below. Trane typically discovers devices on Domain Length: 0. When you 
select 0 as the domain length, the Domain ID (hex): field is disabled.

4. Define the Domain ID (hex). This is the number (it is hexidecimal number) that identifies the 
main LonTalk link on which devices reside for communication or discovery. When 0 is selected 
for the length, the domain field is disabled. However, Rover can now install and discover 
devices on any domain. The domain number you can use depends on the Domain Length 
selected. The list below defines the limitations:

• 1-byte domain length addresses: 00 to FF

• 3-byte domain length addresses: 000000 to FFFFFF

• 6-byte domain length addresses: 000000000000 to FFFFFFFFFFFF

5. Defaults. Clicking on the Defaults button returns the values in both the Domain Length: and 
Domain ID (hex): fields to the factory settings, which are 0 and disabled respectively.

Defining the Installation DSN

The installation DSN is available in the Rover Service Tool Only (refer to Figure 34, p. 51). Trane 
typically installs devices on Domain ID (hex): 11 (Domain Length 1 and Subnet 1). However, Rover 
allows you to install devices on any domain.

1. From the Tools menu, choose Options.

2. Click the Advanced tab (Figure 34, p. 51).

1. Define the Domain Length and Domain ID (hex) values as described in steps 1 and 2 above. With 
the exception that Trane typically installs devices on Domain Length: 1 Domain ID (hex): 11.

2. For installation, you also need to define the Subnet ID. Each device in the domain must have 
the same subnet number to communicate with each other. Numbers from 1 to 255 are valid.

3. Defaults. Clicking on the Defaults button returns the values in both the Domain Length: and 
Domain ID (hex): fields to the factory settings, which are Domain Length: 1, Domain ID (hex): 
11, and Subnet ID: 1.

Discovering Devices on any Domain

The Prompt for automatic domain change on service pin press check box provides a means 
to discover devices that are installed on a domain that is not typically used by Trane. To discover 
devices on any domain:

Note: Do not use this function while Rover is in the Active mode. Only use the Prompt for 
automatic domain change on service pin press check box while in the passive mode.

1. From the Tools menu, choose Options.

2. Click the Advanced tab (Figure 34, p. 51).

3. Select the Prompt for automatic domain change on service pin press check box.

4. Go to any device on the network and press the service pin on that device (only one is required).
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5. Rover sees the request from that service pin and can determine the domain ID of that device. 
The prompt shown in Figure 36 appears.

6. If you want to switch to that domain to discover devices, click Yes.

7. The new domain ID should show up in the Discovery DSN group. Once Rover knows the domain 
ID, it can discover all the devices on that domain.

Figure 36. Switching domains prompt.
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Viewing Device Network Variables 

Network variables data is information a device uses for its internal operation. A device is capable 
of transmitting and receiving data by using the network variable format. This information is used 
for troubleshooting.

Note: This list refreshes the values it displays every five seconds.

To view network variables:

1. In the Active Group tree, click the device you want to view.

2. From the Device menu, choose Network Variables (Figure 37).

3. Click Close.

Viewing a Device Byte List

A device byte list provides internal information about how that device is configured.

To view a device byte list:

1. In the Active Group tree, click the device you want to view.

2. From the Device menu, choose Troubleshoot. 

3. From the Troubleshoot submenu, choose Byte List (Figure 38).

4. Click Close. 

Figure 37. Network Variable View
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Figure 38. Byte List
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Other Rover Software Tools

In addition to Rover Comm4 and Rover LonTalk, the following software tools are available with 
some Rover packages:

• Configuration Builder for offline editing of Tracer MP580/581 controllers

• Air and Water Balancing tool

• Flash Download Wizard

Table 2, p. 9 lists the software tools available with each Rover package.

Starting the Software Tools

To start a Rover software tool:

1. Close Rover LonTalk if it is currently running. 

2. Double-click the Rover icon on your Windows desktop.

3. Click the button for the service tool you want to use (see Figure 39). 

4. For additional instructions, use the online Help for each tool.

Rover Configuration Builder

Rover Configuration Builder is an offline editor for the Tracer MP580/581 programmable controller. 
You can use Rover Configuration Builder to create and edit Rover Configuration Files for Tracer 
MP580/581 controllers, which you can later download to live controllers at a job site. You can even 
create and edit Tracer Graphical Programming (TGP). 

For more instructions and tips on how to use Rover Configuration Builder, use the extensive online 
Help. In Rover Configuration Builder, click Contents and Index on the Help menu.

Figure 39. Rover startup menu

Configuration Builder

Flash Download Wizard

Air and Water Balancing tool
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Air and Water Balancing Tool

Testing and balancing professionals can use the Air and Water Balancing tool to:

• Override individual or groups of variable-air-volume (VAV) boxes

• Calibrate the airflow in VAV boxes

• View the flow readings from VAV boxes

• Override fan control and water valves on equipment

• Create a balancing report

The Air and Water Balancing tool supports the following controllers:

• Tracer VV550 VAV controllers

• Controllers that use the LonMark Space Comfort Controller (SCC) profile.

IMPORTANT
The Air and Water Balancing tool works only with controllers that support the SCC 

profile. In addition, the controllers must support the network variables for airflow. If 

the Start Air Balancing button is not available on the Equipment tab, the controller is 

not compatible with this tool.

Note: You cannot use the Air and Water Balancing tool remotely through Tracer Summit.

Rover Air and Water Balancing Tool allows you to change the network settings used while 
performing this task. This means you can use this tool on non-Trane domains. To change the 
network settings while using the Air and Water Balancing Tool: 

1. Click Settings (Figure 40).

2. The Network Settings dialog appears (refer to Figure 41, p. 58).

3. Set the Domain Length and Domain ID (hex) as described in “Defining the Discovery DSN,” 
p. 52

4. Click OK.

Figure 40. Air and Water Balance Tool main screen
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Other Rover Software Tools
For more information on air and water balancing, refer to the Air and Water Balancing user guide 
in the Rover folder on your hard disk. 

Flash Download Wizard

Use the Flash Download Wizard (Figure 42, p. 59) to update the firmware in Tracer LonTalk 
controllers that have flash memory. You can flash download a single controller or groups of 
controllers of the same type. Depending on the changes to the firmware, the Flash Download 
Wizard usually restores controller configuration data after a flash download but cannot restore 
bindings.

Rover Flash Download Wizard allows you to change the network settings used while performing 
this task. This means you can use this tool on non-Trane domains. To change the network settings 
while using the Flash Download Wizard: 

1. Click Settings (Figure 42, p. 59) if the installed link is on a non-Trane domain. If devices are 
installed on a Tracker loop controller or Tracer Summit BCU, skip steps 1-4 and click Next.

2. The Network Settings dialog appears (refer to Figure 41).

3. Set the Domain Length and Domain ID (hex) as described in “Defining the Discovery DSN,” 
p. 52

4. Click OK.

Figure 41. Network Settings
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Files and Software Required for Flash Downloads

To perform a flash download, you will need:

• The image file or files for the selected controller

• The software plug-in compatible with the image file you want to download to the selected 
controller

Trane will distribute image files and new plug-ins as needed to support upgrades to controller 
firmware.

Guidelines for Performing Flash Downloads

Follow these guidelines for flash downloads:

• Perform a flash download only when directed to do so by a technical support representative or 
a Trane service bulletin.

• Before performing a flash download, use the operator interface to shut down the controlled 
equipment. Controllers cannot maintain control of equipment during a flash download.

• Typically, only perform flash downloads on links managed by Trane. For flash downloads on 
third-party links, use the third-party tool whenever possible or remove the controller from the 
link, then perform the flash download with the Flash Download Wizard. Set the discovery 
domain to the domain where the devices are currently installed using the Settings button in the 
Flash Download Wizard. The third-party network manager must then re-install the device.

• Before you begin, save your controller configuration data to configuration files (RCFs). If your 
controllers have bindings, record the list of bindings for each controller.

• Read the flash download FAQ in the online Help before doing a flash download (Press F1 or click 
the Help button in the wizard).

Note: You cannot perform a flash download remotely through Tracer Summit.

Figure 42. Flash Download Wizard main screen
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Device Plug-ins

Before you can use Rover to configure a controller, Rover must have a software module called a 
plug-in installed for that controller. In most cases, the plug-in should already be installed with your 
copy of Rover.

Each controller and revision of a controller requires its own plug-in. Device plug-ins must comply 
with the EIA/CEA-860 standard for software plug-ins. 

Rover currently has plug-ins to support the following controllers:

• Tracer AH540/541 air-handler controller

• Tracer LonTalk Communication Interface, Chillers (LCI-C)

• Tracer LonTalk Communication Interface, IntelliPak™ (LCI-I)

• Tracer LonTalk Communication Interface, ReliaTel™ (LCI-R)
• Tracer LonTalk Communication Interface, Voyager™ (LCI-V)

• Tracer MP501 setpoint controller

• Tracer MP503 input/output (I/O) module

• Tracer MP580/581 programmable controllers

• Tracer Protocol Interface Controller (PIC)

• Tracer Symbio™ 800

• Tracer VV550/551 VAV controller

• Tracer ZN010 zone controller

• Tracer ZN510/511 zone controllers

• Tracer ZN517 unitary controller

• Tracer ZN520/521 zone controllers

• Tracer ZN523 zone controller

• Tracer ZN524 water-source heat pump controller

Plug-ins are made available for new Trane LonTalk controllers as they are developed. To add a plug-
in or to find out what additional plug-ins are available, contact your local Trane representative or 
check the TraneNet information system.
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Frequently Asked Questions
Frequently Asked Questions

What controllers work with Rover LonTalk? 

At this time Rover works with the following controllers:

• Tracer AH540/541 air-handler controller

• Tracer LonTalk Communication Interface, Chillers (LCI-C)

• Tracer LonTalk Communication Interface, IntelliPak (LCI-I)

• Tracer LonTalk Communication Interface, ReliaTel (LCI-R)
• Tracer LonTalk Communication Interface, Voyager (LCI-V)

• Tracer MP501 setpoint controller

• Tracer MP503 input/output (I/O) module

• Tracer MP580/581 programmable controllers

• Tracer Symbio™ 800

• Tracer Protocol Interface Controller (PIC)

• Tracer VV550/551 VAV controllers

• Tracer ZN010 zone controller

• Tracer ZN510/511 zone controllers

• Tracer ZN517 unitary controller

• Tracer ZN520/521 zone controllers

• Tracer ZN523 zone controller

• Tracer ZN524 water-source heat pump controller

Rover can communicate only with controllers that use the LonTalk communications protocol. 

What is the difference between EveryWare and Rover Comm4?

With Rover Comm4, you can do everything you can do with EveryWare. The only difference is that 
Rover Comm4 runs in Windows.

When do I need the communication key? 

You require a communication key whenever you use Rover with a non-communicating device, such 
as the Tracer ZN010. The key is designed to be inserted only one way and when plugged in properly, 
it enables LonTalk communications on devices that do not have permanent communications 
capability. The communication key is not needed for boards with an on-board communications 
transceiver (an electrical component about a half-inch square labeled FTT-10A).

What operating system do I need to run Rover? 

Rover runs on Windows 7 Enterprise or Professional or Windows 10 operating systems.

How do I set or view the communications address of LonTalk devices?

You do not need to set the communications addresses for LonTalk devices. LonTalk devices are 
uniquely identified by their Neuron IDs. The Neuron ID is printed on the board and is displayed by 
Rover when communication is established. An example of the Neuron ID format is 00-01-64-1C-2B-
00. The Neuron ID is unique and cannot be changed.

Do I have to use 800 × 600 screen resolution?

Rover is designed for 800 × 600 minimum resolution screen size. It is highly recommended that you 
use this resolution when operating Rover because at lower resolutions some screen functions are 
not visible.
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Frequently Asked Questions
Can I purchase the items that came in my Rover package separately?

Yes, there is a list of service part numbers for several items in Table 1, p. 8. Contact your local Trane 
sales office to order any of these items.

My laptop PC has two USB ports. Which one should I use for the USB adapter?

You can use either empty port for the USB adapter.

Why are the devices not communicating with Rover?

Check the status bar to make sure the network interface is correct and then check your connections. 
If the yellow communications LED on the device is on, you might need a termination resistor on 
the controller. Depending on the installation, you may need to place a 105  resistor across two 
open COMM terminals on the controller.

Why am I unable to see all the network variables in the add network binding lists?

The binding utility prevents binding incompatible variables together. You see all the devices as 
choices in Step 1 on the Add Network Variable Bindings dialog box, but only compatible variables 
are shown as potential devices with which to bind in Step 4. You may have two compatible devices, 
but you see only network variables that can actually be bound to the variable chosen from the first 
device. If you have more than one device selected in Step 3, only the network variables that are 
commonly compatible are available for binding.

What are the values shown in the network variables list and the byte list?

The values in the network variables list and the byte list are raw data from the controller shown in 
hexadecimal format. 

When should I turn on the auto-identify option?

You should turn on the Auto-identity option to identify a device. When this option is enabled, press 
the service pin on a device to:

• Add a newly installed device to Active Group tree
• Make the device the active device in Rover (thereby identifying the device)

It is helpful to have two people when using Auto-identify. While one of you watches the Rover 
window, the other can press the service pin button on a distant device.

Do no enable Auto-identify during discovery, or every device found attempts to display its status 
in the workspace, slowing the discovery process.

Where can I get plug-ins for versions of devices that are not on my laptop PC?

All supported device plug-ins are installed when you install Rover. As new device plug-ins become 
available, Trane will announce the methods for obtaining and installing them. 

Rover is not discovering any devices. How can I check my USB communications?

Anytime you are having trouble communicating with your devices, you can first check to see if your 
USB communications adapters are running correctly. See the installation sheet for more 
information on checking your communications.
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Glossary

A

Active Group

The devices available on a communications link.

Active Group tree

A visual representation of the active devices on the Rover 
screen.

Active Mode

Use the active mode when using Rover to configure a 
Trane peer-to-peer network. Do not enter the active mode 
on third-party networks or on Trane networks with Tracker 
controllers that have not yet been installed. In the active 
mode, you can use Rover to perform network 
management tasks, including creating bindings and 
cleaning up links. See also server-connected mode, 
passive mode.

Auto-identify

An option in Rover that automatically identifies a device 
when its service pin button is pressed. If Rover is running 
on a site, you can press the service pin button on a device 
communicating on the link. When you return to your 
laptop PC, the device is selected in the Active Group tree, 
and the device status appears in the workspace.

Auto-wink

An option in Rover to automatically wink a device when 
the service pin button is pressed on that device. If you 
have Rover running on a site, you can press the service 
pin button on a device. If the status LED blinks, you know 
that device is communicating without having to go back to 
your laptop PC.

B
BCU

Building control unit. A Tracer Summit field panel that 
coordinates system-level control of multiple unit 
controllers. The Tracer Summit PC Workstation 
communicates with BCUs to monitor and control sites. 

Binding

Bindings allow two or more devices to share common 
information, such as the same setpoint or zone 
temperature sensor. Bindings link a network variable in 
one device with a network variable in another device to 
share data between the devices.

C

Communication Key

The communication key provides temporary 
communications capabilities to stand-alone devices. 
Attach the communication key to the device while it is 
communicating and remove it when the work is complete.

Configuration

The configuration is the set of parameters downloaded to 
a device that condition the device and determine its 
function of operation. Typically, the device installer sets 
these parameters.

CRC (Cycle Redundancy Check) Error

CRC errors are a means of verifying the accuracy of 
transmitted data by adding on summary data values. They 
occur when the summary data value sent is not the same 
as the summary data value received.

D

Device 

In this user guide, device refers to any controller that uses 
the LonTalk communications standard.

Discover

The Discover command checks the active link for 
communicating devices and adds any new devices to the 
Active Group tree.

Domain ID

The domain ID is the network domain on which a device 
communicates.

F
Flash Download Wizard

The Flash Download Wizard downloads an image file to a 
controller to update its firmware. The wizard can perform 
flash downloads only to controllers that have flash 
memory. See also image file.

I

Identify

The Identify command locates the device you selected in 
the Active Group tree. Rover prompts you to press the 
service pin button on the device. When Rover receives the 
message from the device, the device is selected in the 
Active Group tree.
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Image File

A file that holds the firmware for a particular version of a 
controller. Image files are required to perform a flash 
download. The firmware revision number is included in 
the file name. Image files can have NXE, IMG, or XIF file 
name extensions. See also Flash Download Wizard.

Inch-pound (I-P) Units

Units of measurement often used in the United States. 
These include degrees Fahrenheit, inches, and gallons.

International System of Units (SI)

Units of measurement including meters, kilograms, liters, 
and others. The acronym SI comes from the French name 
Système International d’Unités.

L

Last Reset

The cause of the device last reset, such as a power failure 
or a software command.

Link

The communications wire that connects devices to other 
devices or to Rover.

LonTalk Link

Any physical network made up of devices that 
communicate using the LonTalk.

Lost Message

Application messages lost between the Neuron processor 
and ROM chip(s). Lost messages occur when too many 
messages are sent to the device and the device Neuron 
processor cannot handle all the messages coming in.

M

Missed Messages

Messages that require acknowledgment but have not 
received acknowledgment after three requests.

Most Recent Error

A numerical value showing the most recent error the 
device detected while communicating on the network. 
This error does not mean the device is not working 
properly. A most recent error is used for troubleshooting.

N
Network Variable

A device input or output data item. Network variables 
enable a device to exchange data values with other 
devices on the network.

Neuron ID

The Neuron ID is a unique identifying number assigned by 
the manufacturer to identify every device produced.

Node ID

The unique logical location assigned for a device on the 
network domain and in the logical subnet.

Not Communicating

The operational state of a device when it is not 
communicating on the network.

O

Offline

The operational state of a device in which it remains 
available on the Rover communications link for 
troubleshooting activities but is not transmitting 
messages.

Offline Editing

The ability to edit Rover configuration files (RCFs) while 
not connected to a live controller. The Rover Configuration 
Builder is the tool used for offline editing. Only the Tracer 
MP580/581 programmable controller supports offline 
editing.

P
Passive Mode

In the passive mode, Rover cannot manage networks. 
This is the safest (and default) mode of operation. In the 
passive mode, you can use Rover to configure controllers 
but cannot create bindings. Always use the passive mode 
on third-party (non-Trane) networks. Also use the passive 
mode on Trane networks with Tracker controllers that have 
not yet been installed. For faster performance, you can 
use the passive mode on Trane networks with a BCU or 
Tracker. See also server-connected mode, active mode.

Peer-to-peer Network

A network of controllers without a server (BCU, Tracker, or 
Tracer loop controller) on the link. For example, two Tracer 
ZN511 zone controllers linked together with bindings form 
a peer-to-peer network.

Ping

A method of testing whether a computer is connected to 
a network by sending a packet and waiting for a response.
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Plug-in

A plug-in is a software module required by Rover to 
interact with a device, such as a Tracer ZN510 zone 
controller. Each device and revision of a device (identified 
by a unique program ID) requires its own plug-in. Devices 
that do not have plug-ins are considered unknown 
devices. Rover cannot be used to configure unknown 
devices, and can report only general information about 
them. 

Program ID

A LonMark® identification number for the firmware of a 
controller. Major firmware revisions can be identified by 
their program IDs; however, for Tracer controllers, the 
revision number is a more reliable way to identify 
firmware revisions. Each firmware revision with a new 
program ID requires its own Rover plug-in.

R
RCF

RCF (Rover configuration file) is a file format that can be 
copied and used to configure other devices.

Remove

A command used to remove a device from the Active 
Group tree.

Reset

A command to restart the device processor.

Revision Number

An identification number that Trane assigns to the 
firmware of a controller. Each version of the firmware 
receives a new revision number. The revision number is 
more reliable for identifying firmware versions than the 
LonMark® program ID, which may not change for each 
revision. The revision number is included in the filename 
of an image file.

Rover Comm4

An optional Rover application for monitoring, configuring, 
and testing VAV II/III/IV controllers and the terminal unit 
controller (TUC) on Comm4 links. Rover Comm4 replaces 
the EveryWare service software.

Rover LonTalk

An optional Rover application for monitoring, configuring, 
and testing Tracer LonTalk controllers. See also LonTalk 
link.

Rover Configuration Builder

An offline editor for Tracer MP580/581 Rover configuration 
files (RCFs).

Rx Buffer Full

The Rx buffer full is an error message that states that the 
receiver buffer is full and the Neuron processor can no 
longer process incoming information. The Rx buffer 
records the number of times incoming information has 
been discarded because there was no room to store it.

S
Self-documentation String

The internal description of a device.

Server-connected Mode

Rover can enter the server-connected mode when another 
server, such as a BCU or Tracker controller, is on the link. 
In this mode, you can use Rover to create bindings. Rover 
cannot enter the server-connected mode on third-party 
networks. See also active mode, passive mode.

Service Pin

A button on a device that allows the installer to locate and 
identify a specific device on the network. When pressed, 
the device Neuron ID is sent to Rover.

SI

See International System of Units.

Site

In Tracer Summit, a number of unit controllers and building 
control units arranged into a logical group, such as a single 
building. A Tracer Summit PC Workstation can 
communicate with multiple sites remotely by modem or 
locally over BACnet/IP, Ethernet, or ARCNET networks.

Subnet ID

The logical network subnet on which a device 
communicates.

T

Termination Resistor

A resistor used to bleed off noise and condition the signal 
going down the communications wire. 

Test

The Test command is a low-level test that transmits 
diagnostic information to the Device Test dialog box.

TGP Editor

The Tracer graphical programming (TGP) editor provides 
an environment to create graphical programs for 
compatible devices. The TGP editor is available on plug-ins 
for compatible controllers, such as the Tracer MP580/581 
programmable controllers.
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Timeouts

Errors produced when Acknowledge Required messages 
are not being acknowledged.

Tracer Summit Software

Trane’s software for managing applied building automation 
systems. With Rover Version 6.0 and Tracer Summit 
Version 17.0, you can run Rover within Tracer Summit to 
configure controllers locally and remotely.

Transceiver

A chip built in to controllers that allows LonTalk 
communications.

Tree

The visual organization of groups and devices on the 
Rover screen.

U
UCM

Unit control module. An acronym commonly used to refer 
to unit controllers, such as the Tracer ZN510 zone 
controller. In Rover, controllers are often called devices.

Unknown Device

A LonTalk device that Rover cannot recognize because it 
does not have a plug-in for the device. Rover cannot 
change any information on the device but can read some 
information from the device.

USB Adapter

A plug and play interface between a computer and add-on 
device.

W

Wink

A command to flash the status LED on a selected device 
so that you can associate a physical device with a named 
device in a group.
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